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MS-PowerPoint 2013 

1.1 Introduction to PowerPoint 
Microsoft PowerPoint is a software product used to perform computer-based presentations. 

There are various circumstances in which a presentation is made: teaching a class, introducing a 

product to sell, explaining an organizational structure, etc. 

PowerPoint is the presentation graphics 

software. It is a part of Microsoft Office Package. 

Using PowerPoint one can create various 

presentation including charts, graphics, text, audio 

and video. It creates slide shows which are 

basically electronic presentation that you can run 

on your computer screen therefore PowerPoint is 

popular presentation graphic software.  

1.2 Why Presentation? 

The purpose of any presentation, written, oral or visual, is effective communication. This 

requires to put forth facts in a simple, concise and interesting manner. It is proven that the people 

learn more readily and retain more information when learning is reinforced by visualization. 

You can entertain, inform, excite and even shock an audience by the proper integration of 

visual images into virtually any exchange of information. Meetings which might normally be 

considered dull, or a chore to be avoided, can be transformed into exciting productions that grab the 

attention of the viewers. 

Simple, clear, concise visual images, briskly paced and sprinkled with attention-grabbing 

graphics will lend support to your spoken words. This leaves your audience with a positive attitude 

toward your product, service or proposal. 

Visuals in business should be used in 

support of the spoken or written word, and not in 

lieu of it. A well-developed concept and effective 

script are the essential elements of any 

presentation. Regardless of their form, they should 

be the first and most important phase of its 

development. 

You can easily communicate concepts that 

are difficult to grasp through the intelligent use of 

professionally produced visuals. This allows the 

freedom to communicate more complex subject 

matter in a more efficient manner, adding support and impact to your script. 

Finally, your presentation should be entertaining. Leave the audience feeling better and more 

relaxed when they leave and that impression will carry over to both your subject matter and yourself. 

There is no logical reason that the presentation of routine sales figures and financial reports should 

not be as exciting as the unveiling of a new product or a first rate service proposal. 

 

1.3 Basic rules to create a Presentation 

1.3.1  Use a Maximum of 15 Slides  

The average presentation slot or business meeting lasts an hour. By the time you meet and 

greet and get through the inevitable A/V issues (the projector isn't working, you can't find the right 

adapter for your Mac, or someone is dialing in but having trouble), you're down to 45 minutes. 

Since you'll always want to encourage discussion and ample time for Q&A, you have about 30 

minutes left. 
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Using the rule of thumb that it takes about two minutes to present a slide, you have just 

enough time to present 15 slides effectively. Boil down your story to just the key points and move 

the rest of the slides to the appendix as a leave behind. 

1.3.2  Make Your Titles Headlines, Not Descriptions 

Each section of your slide is a valuable piece of real estate, adding information or insight to 

the story you're trying to tell. When you use a title that simply describes what's on the slide, 

you're wasting valuable real estate. For example:"2013 Revenue" is a description. "2013 

Revenue Grew 44%" is a headline. 

The best titles provide context and explain the slide's content, as well as conclusions -- the 

core point of your slide. 

1.3.3 Let the Titles Tell the Story 

Related to the last point, many clients often find themselves struggling with the order of their 

slides. A good trick I use is to see if the titles can tell your story. That is to say, you should be able 

to read just the titles of your slides out loud in order and understand the essence of your 

presentation. If you can't, or if the order sounds off, chances are your titles aren't headlines 

(they're descriptions) or you need to reorder your slides. 

1.3.4 Layout Counts  

The most important information on your slide should go in the title, the upper left-hand 

position, and at the very bottom, since in Western cultures we tend to read left to right, top to 

bottom. Our eyes tend to jump to these areas. Try putting your slide's key takeaway in a shaded 

callout box in the bottom; color helps distinguish the information from the rest of the slide's 

content. 

1.3.5 Give Your Audience a Roadmap  

Just like passengers in a car, your audience will feel more comfortable if you let them know 

where you're headed. Agenda slides and divider slides can help, but they merely order your 

presentation; they don't organize it. 

What I'm really talking about is having a framework to your story. Frameworks structure 

your narrative and help keep your audience engaged because they will always know where they 

are within your story. Here are some example frameworks: 

• Three pillars of your product's value 

• 10 trends in the market 

• A day in the life of your consumer 

Regardless of the framework you choose, it will only be effective if you stick to it. If you 

show a slide that says your product works in three environments: at home, at work, and on the 

go, the next slide that follows needs to be a deep dive on how your product works in the home, 

followed by a slide about your product at work, and finally by a slide about your mobile product. 

We're human. We like order. Frameworks provide it. 

1.3.6 Vary Your Format 

Humans like order, but we also crave variety. If you show a slide or two with charts, make 

the next slide a big, beautiful visual. If you tend to have bulleted lists on the left-hand side, switch 

it up and place the list on the right. The change in pacing and visual rhythm will keep your 

audience engaged. 

1.3.7 Bubbles, Callouts and Takeaways 

Think of your slide as an onion - there are layers to the story you're trying to tell. Bubbles, 

callout boxes, and key takeaways will add dimension to your story. So show the chart, but also 

point out the interesting data point within it, the implication of the trends behind it, and the take 

away from it. 
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1.3.8 Always Close With an Ask 

You'd be surprised, but the majority of presentations we see just, well, end. We even hear 

speakers conclude with "Well, that's it." What a waste! Always close with an ask. The ask can be 

for commitment to a project, for marketing dollars, or to continue the conversation. In a speaking 

engagement setting, the ask could be for the audience to think about the implications of what 

you've shared, or how it will affect the way they approach their jobs.  

1.4 Presentation and slide  

A slide is a single page of a presentation created with software such as PowerPoint. A 

presentation is composed of several slides. The best presentations use approximately ten to 

fifteen slides to get the message across. 

A power point presentation of a file is a group of various slides. A slide is nothing but an 

electronic page. 

1.4.1 Components of a Slide 

A slide is an individual page of a presentation. It is the container of information present in 

the form  

 Text 

 Pictures 

 Clipart 

 Word Art 

 Excel 

sheet 

 Charts 

 Audio 

 Video etc 

http://presentationsoft.about.com/od/s/g/slide_show.htm
http://presentationsoft.about.com/od/powerpointtips/qt/planningppt.htm
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Starting Presentation in PowerPoint 

2.1  How to start PowerPoint 

1.  Click the Start button. The Start menu 

appears. 

2.   Click All Programs. The left pane of the 

Start menu displays the programs and 

menus installed on your computer. 

3.   Click Microsoft Office 2013. 

4.   Select PowerPoint 2013. 

The PowerPoint 2013 program screen 

appears. 

 

  Other Way to Start a Program: 

Click the Start button and type the Program 

name in the Search box. Click the Program 

inthe search results to launch it. 

 

 Tips: 

 If you use PowerPoint2013 frequently, 

you might consider pinning it to the 

Start menu. To do this, right-click 

PowerPoint2013 in the All Programs 

menu and select Pin to Start Menu. 

 Windows7 users can also pin a program to the taskbar. To do this, right-click the 

PowerPoint button in the taskbar and select Pin this Program to taskbar from 

the contextual menu. 

Figure2-1: The All Programs menu in Windows7 
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2.2 Exploring  the Microsoft Office PowerPoint environment 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure2-2: Different components of PowerPoint Window 

 

 
 

FILE tab: Contains basic file 
management commands such as New, 
Open, Save and Close and program 

 
 

Notes pane: Type any notes you want to 
use during a presentation here. 

 
 

Quick Access Toolbar: Contains 
common commands such as Save and 
Undo. You can add more commands as 
well. 

 
 

Zoom slider: Click and drag the slider to 
zoom in or out of a window. You can also 
use the + and –buttons. 

 
 

Title bar: Displays the name of the 

presentation you are working on and the 
name of the program you are using. 

 
 

View buttons: Use these buttons to 

quickly switch between Normal, Slide 
Sorter, Reading and Slide Show views. 

 
 

Close button: Click the close button in 
the Title bar to close the presentation or 
to exit the PowerPoint program entirely. 

 
 

Status bar: Displays messages and 
feedback on the current state of 
PowerPoint. Right-click the status bar to 
configure it. 

 
 
 

Ribbon: The tabs and groups on the 
Ribbon replace the menus and toolbars 
found in previous versions of 
PowerPoint. 

 
 

 

Outline pane: Focuses on the content of 
your presentation rather than its 
appearance. 

 
 

Slide pane: Displays the slide you are 

currently working on. 

 
 
 Figure 2-3: Description of different parts of the Microsoft Office PowerPoint 2013 screen 
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2.3  Create a new presentation 

Creating a new presentation is one of the most basic functions you need to know how to 

use. You can create a new presentation in two different ways. Namely  

• By using Template 

• By using Blank Presentation 

 

2.3.1 Using Template 

PowerPoint has the ability to use templates to create presentations. These templates are 

designed to give your slide presentations a consistent appearance. Templates are ready-to-use 

presentations into which you put your own information. You can use the templates provided or 

create your own template also when you will be expert on presentation. 

Design templates contain color schemes, slide and title masters with custom formatting, 

and styled fonts designed for a particular "look." When you apply a design template to your 

presentation, the slide master and color scheme of the new template replace the slide master 

and color scheme of the original presentation. After you apply a design template, each slide you 

add, regardless of the Auto Layout has the 

same custom look. 

2.3.1.1 Create a presentation from  

             a template 

1.  Click the FILE tab on the Ribbon 

and select New. 

The New tab of Back stage view 

appears with a few of the most 

popular template options to choose 

from. 

2.  Select a template from the options 

displayed. 

3.  Choose a color scheme for your 

template and click Create.  

 

2.3.2 Using Blank Presentation 

 Though there is a verity of Templates 

available in PowerPoint, You can create 

your own presentation by a Blank 

presentation when you will be very 

conversant with this application.   

2.3.2.1 Create a new blank presentation 

1.  Click the FILE tab on the Ribbon 

and select New. 

The New window of Back stage view 

appears. 

2.  Click the Blank Presentation 

option. 

The new blank presentation appears in 

the PowerPoint application screen. 

Other Way to Create a Blank Presentation: Press <Ctrl> + <N>. 

2.4 Saving a Presentation 

After you’ve created a presentation, you need to save it as saving a file means to store it in 
secondary storage device so that it can be used later. Also, if you make changes to a 

presentation you’ll want to save it. You can even save a copy of an existing presentation with a 

Figure 2-4: The New tab of Backstage view 

Figure 2-5: The New tab of Backstage view 
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new name, to a different location, or using a different file type. When you will save the file, the file 

will be saved with extension .pptx. 

 
1.  To save a presentation for 

the first time, click the Save 

button on the Quick Access 

Toolbar. 

The Save As dialog box will 

appear as displayed in Figure 

2-6 

2.  Specify the drive and/or 

folder where you want to save 

your presentation. 

The Save As dialog box has 

several controls that make it 

easy to navigate to locations 

on your computer: 

 Address bar: Click a 

location in the Address 

bar to open it. Click the 

arrow to the right of a location to 

view a list of folders within that location. Select a folder from the list to open it. 

 Folders List: Shortcuts to common locations on your computer, such as the  Desktop 

and Documents library. 

 Search box: This searches the contents including sub folders of that window for the 

text that you type. If a file’s name, file content, tags, or other file properties match the 

searched text, it will appear in the search results. Search results appear as you enter 

text in the search box. 

3.  Enter the file name in the File name text box. 

4.  Click Save. 

. Other Ways to Save: 

Press<Ctrl>+ <S>. 

Or, click the File tab and 

select Save As. 

 
2.5  Open a presentation 

You can locate 

presentation on your computer 

and simply double-click it to 

open it, but you can also open 

a presentation in the 

PowerPoint program. 

1. Click the FILE tab and 

select  Open. 

The Open dialog box appears. Next, 

you have to tell PowerPoint where 

the file you want to open is located. 

Other Way to Open a Presentation: 

Press<Ctrl>+ <O>. 

 

2.  Select Folder, File and click Open. 

 

Figure 2-6: Save As dialog box 

Figure 2-7: File Open  dialog box 
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Tips: 

 

 To open a presentation that has been used recently, click FILE>Open>Recent 

Presentations, and select a presentation from the Recent Presentations list. 

 

2.6  Closing a Presentation 

When you’re done working on a presentation, you need to close it. 
1.   Click the FILE tab and select Close. 

 

The presentation closes. You can access the file again by opening it later. 

 

Other Ways to Close a Presentation: 

Press <Ctrl> + <W> 

Or, Press <Ctrl> + <F4> 

Or, click the Close button in the upper right corner of the PowerPoint window. 

Tip: If you have multiple presentations open, clicking the active presentation’s 
Close button only closes that one presentation. The other presentations remain 

open in their windows until you click their close buttons as well. 

 

2.7  Exiting Power Point 

When you’re finished using PowerPoint 2013, you should exit it. Exiting a program closes it 

until you need to use it again. 

 

1.   Click the Control Box at the top left Corner of the window. 

2.   Click the Close button. 

The PowerPoint  program window closes. 

Other Ways to Exit PowerPoint: 

Press <Alt> + <F4> 

Or, click the Close button in the upper right corner of the PowerPoint window if you have 

opened only one presentation. 

 

2.8  Shortcuts  

Action Shortcut key 

New Presentation Ctrl+N 

Open Presentation Ctrl+O 

Save Presentation Ctrl+S 

Closing Presentation Ctrl+F4 

Exiting Presentation Alt+F4 



9 | P a g e  

 

Modifying a Presentation 

3.1 Theme 
A theme is a set of unified design elements that you can apply to a presentation to give it a 

consistent look and feel. Each document theme consists of three design elements: 
 
 Theme Colors:  A set of eight coordinated colors used in formatting text    

           and objects in the presentation. 

 Theme Fonts:  A set of coordinated heading and body font types. 

 Theme Effects:  A set of coordinated formatting properties for shapes   

           and objects in the document 

PowerPoint applies the selected theme to all of the slides in a presentation. To apply a 

theme to a single slide/ to a number of slides, select the slide(s), then right-click on the 

theme you want to apply, and select Apply to Selected Slides from the contextual menu. 

3.1.1 Apply a document theme 
Applying a document theme affects all 

elements of a presentation: colors, fonts, and 
effects. 
1.  Click the DESIGN tab on the Ribbon and 

click the More button( ) in the Themes group. 

The Themes gallery appears. The default 

theme is “Office,” which is highlighted in 

orange. 
 

Tip: Click Browse for Themes to 

navigate to the theme’s location on your 

computer or network. 

2.  Click the theme you want to apply.   

        The formatting associated with the 

Selected theme is applied to all of the 

slides in the presentation. 

3.1.2 Apply Theme Colors, Theme Fonts, 
or Theme Effects a document  
theme 

You are not bound to keep the colors, fonts, or effects that are assigned to a document 

theme. You can mix and 

match theme colors, theme fonts, and theme effects to meet your needs. 

1.   Click the DESIGN tab on the Ribbon. 

2. Click the Theme Colors, Theme Fonts, or Theme Effects button in the Variants group and 

select the colors, fonts, or effects that you want to use. 

     PowerPoint applies your changes to the presentation. 

 
3.2  Adding / Inserting new slide(s) 

Slides are the building blocks of a presentation. Inserting a new slide is quick and easy . 

Click the HOME tab on the 
Ribbon and click the New Slide 
button in the Slides group. A new 
slide is added/inserted to the 
presentation. 

Other Ways to Insert a New 

Slide: Press <Ctrl> + <M>. Or, 

right-click on a slide in the 

Outline pane and select New 

Slide from the contextual menu. 

 
Figure 3-2: New Slide button 

  Figure 3-1: To preview how a theme will look in the current  
  presentation, point to it to enable Live Preview. 
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3.3  Delete slide(s) 

If you decide you don’t need  slide(s), delete it. 
 

1.   In the Outline pane, select the slide(s) you want to delete. 

2.   Press <Delete>. 

The slide is deleted. 

 

Other Ways to Delete a Slide: 

In the Outline pane, select the slide(s), right-click on Slide(s) 

you want to delete and select Delete Slide from the contextual 

menu. 

 

3.4  Duplicating slide(s) 

If you need slide(s), which may require slight change, it is better to 

have the duplicates of them.  

1.   In the Outline pane, select the slide(s) you want to get duplicate. 

2.   right-click on Slide(s) and select Duplicate Slide from the 

contextual menu. 

Or , Use shortcut Ctrl+D 

 
3.5  Shortcuts  

 

Action Shortcut key 

Adding or Inserting new Slide Ctrl+M 

Delete Slide(s) Delete 

Duplicate of Slide Ctrl+D 

 

3-3: Contextual menu 
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Working with Slide 
 

4.1 Adding text 

One can add text into a slide by using 

 Text Placeholders 

 Adding Text Boxes 

  4.1.1. Text Placeholders 

Every slide has one or more areas, 

called placeholders, where you can insert 

text. Placeholders are hard to miss, since 

they’re labeled “Click to add title” or 
“Click to add subtitle” or “Click to add 

text” and are extremely easy to work with. 
1. Click the placeholder where you 

want to insert your text. 

2. An insertion point appears inside the 

placeholder. 

3. Start typing.     

4. The new text appears on the slide. 

 

Tips: 

 Placeholders  grow and shrink to accommodate any text hat you enter. 

 If you are creating a bulleted list, press<Enter>after each paragraph to add another bullet to 

the list. 

 You can also move, resize, copy, 

or delete placeholders 

 

4.1.2 Adding Text Box 

Even though most slides have 

one or two placeholders for you to 

insert text, it’s a good idea to learn how 
to insert your own—especially if you 

plan on creating a blank presentation 

any time soon. 

Create a text box 

1.  Click the INSERT tab on the Ribbon 

and click the Text Box button in the 

Text group. 

The pointer changes to a “ ”, 
indicating you can draw a text box. 

2.   Position the mouse pointer where 

you would like to insert the text box, 

and click and drag until the text box 

reaches the desired size. 

3.   Release the mouse button. 
4.1.3 Insert text in a text box 

As soon as you finish creating a text box, 

a blinking cursor appears inside it, indicating that you can add text. 

•     Click the text box and start typing. 

4.2 Adding Text Box 

4.1 Placeholder to add text 
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4.2 Adding Bullets/Numberings 

 

Use bulleted lists when the order of items in a list doesn’t matter, such as listing 
items you need to buy. When the order of items in a list does matter, such as to present step-

by-step instructions, use a numbered list. 

 

1.  Select the paragraphs that 

you want to bullet or 

number. 

 

Each line that you want to 

be bulleted or numbered 

must appear as its own  

paragraph. 

 

2.  Click the HOME tab on the 

Ribbon and click the 

Bullets or Numbering 

buttons in the Paragraph 

group. 

 

The selected lines are 

bulleted or numbered accordingly. 

 

 

Tip: 

 

 To remove bullets and numbering from a list, select the list that is already bulleted and click 

the Bullets or Numbering button in the Paragraph group. 

 

4.3  Formatting text 

Formatting text refers to change the font type, font style such as Bold, Italic, Underline, font 

size, and font color of the text . Besides that we can copy 

all the formats from one text to other by using “Format 

Painter”. 
1.  Select the text you wish to format. 

2.  Click the HOME tab on the Ribbon and click the Font  

Drop down list to change Font, click the Font Size list 

arrow to change Font Size,  font color list arrow to 

change Font Color and the respective style button as required in the 

Font group.  

 

4.4  Copying Formatting 

If you find yourself applying the same formatting over and over again, then you should 

familiarize yourself with the Format Painter tool. The Format Painter copies how text or objects 

are formatted and lets you apply that formatting elsewhere. 

1.  Select the text with the formatting you want to copy. 
 

The Format Painter will copy character formatting such as font type, color, style and 
paragraph formatting such as line spacing, indentation formatting attributes of the selected 
text. 

2.  Click the HOME tab on the Ribbon and click the Format Painter button in the Clipboard 
group. 

4.3 Selecting Bullet 

4.4 Font Group buttons 
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The selected formatting is copied and the pointer changes from an to a . 
 

Tip: Single-click the Format Painter button to apply copied formatting once. 
Double-click the Format Painter button to apply copied formatting multiple times. 

3.  Click and drag the pointer across the text to which you want to apply the copied 
formatting. The copied formatting is applied. 
 

Tips: 
 

 If you double-clicked the Format Painter button in Step2, click the Format Painter 
button again to deactivate it, or press <Esc>. 

 
 You can also use the Format Painter command to copy the formatting of objects, 

such as shapes, and apply that formatting to other objects. 

4.5 Using WordArt 
 

Using PowerPoint’s 
WordArt feature is the 
fastest and easiest way to 
add dramatic and colorful 
effects to the text on your 
slides. 

 
4.5.1 Insert WordArt 

1.  Click the INSERT tab on 
the Ribbon and click the 
WordArt button in the Text 
group. 

The WordArt Styles 
gallery appears. 

2.  Select a WordArt style 
from the gallery. 

A textbox formatted using the 
WordArt style you selected appears on 
the slide. 

3. Type your text. 

 

4.5.2 Modify WordArt 

You can also modify WordArt once it has been inserted. For example, you can change the 
text fill and outline color, choose a new WordArt style, or apply a cool text effect. 

 
1.  Select the text that you want to format 

and click the FORMAT contextual tab on the 

Ribbon. 

 

2.  Use the commands found in the 

WordArt Styles group. 
 

Tip: You might notice a little circular 

arrow( )next to some WordArt objects. This 
is called an adjustment handle, and it is used to change the angle at which some WordArt 
effects slant or loop. Simply click and drag this adjustment handle to adjust the effect. 

 
4.6 Inserting Shapes 

PowerPoint 2013 comes with an extensive set of ready- made shapes, called AutoShapes. 

You can use these to easily draw shapes on your slides. The Shapes gallery contains over a 

hundred common shapes and lines, such as stars, arrows, and speech balloons. 

4.5 Word Art style Gallery 

4.6 Format Contextual tab on Ribbon  
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4.6.1 Draw a shape 

 
To insert a shape 

into a presentation, draw 
it. 

 
1.  Click the INSERT tab 
on the Ribbon and click 
the Shapes button in the 
Illustrations group. The 
Shapes gallery appears. 

2.  Click the shape you 
want to insert. 

 
The arrow pointer changes 
to a crosshair. 

 
3.  Click and drag on the 

slide until the shape 
reaches the desired 
size. 

 
Tip:To draw a 
straight line, perfect 
square or circle, or 
to constrain the 
dimensions of other 
shapes, press and hold 
down the<Shift>key as 
you drag. 

 
 

 
4.  Release the mouse button. 

 

The shape is inserted onto the slide and the FORMAT 
contextual tab appears on the Ribbon under DRAWING 
TOOLS. 

 
Other W ay to Insert a Shape: Click the HOME tab on 

the Ribbon and select a shape from the box in the 

Drawing group. 

 
4.6.2  Adjust a shape 

 
You can adjust the most prominent feature of a shape— such 

as the point of an arrow or the spikes on a star by using its 

adjustment handle. 

1.  Click the shape to select it. 

2.  Click and drag the shape’s adjustment 

handle 

3.  Release the mouse button. 

                        4.7 Types of  Auto Shapes 

4.8 Format Contextual tab on Ribbon with Auto Shapes 

4.9 Auto Shape Handles to Adjust Shape 
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 Tip: Some shapes have more than one adjustment handle, while others don’t have any at 
all. 

4.6.3 Add text to a shape 
 

Adding text to a shape is extremely easy—just click the shape and start typing. 
 Click the shape you want to add text to and start typing. 

 
Other Ways to Add Text to a Shape: 

Right-click the shape you want to add text 
to, Select Edit Text from the contextual 
menu, and type your text. 

 

4.7  Inserting ClipArt 

ClipArt is a collection of pictures and 

graphics that Microsoft has included  with 

PowerPoint. 

1.  Click the INSERT tab on the Ribbon 

and click the Online Pictures  

             button in the Images group. 
The Insert Pictures dialog box appears. 

2.  Type the name of what you’re looking 
for in the “Office.comClipArt” text box. 

3.  Click the magnifying glass( )to search or press<Enter>. 
 

Tip:If you have a Microsoft Account and 

you are signed in, you will also have access 

to images sources like Flickr, Facebook and 

other similar sites. 

4.  Scroll through the clipart until 

you find a file that you like. 

    5.  Click the clipart that you want to 

insert and click Insert.  

The dialog box closes. 

 

 Tip: A little star in the bottom-right 

corner of a graphic indicates animation. 

 

4.8 Table 

In order to create a table in 

Microsoft PowerPoint, you first specify how many 

columns (which run up and down) and rows 

(which run left to right) you want to appear in the 

table. The number of columns and rows 

determines how much information the table can 

contain. If you are not sure about your 

information and do not predict rows and columns, 

then do not worry. Add minimum rows and 

columns and when you will enter text and press 

tab, rows will go on increasing. 

 
4.8.1 Insert a Table 

1.  Select the slide that you want to add a 

table to. 

2.  Click the INSERT tab on the Ribbon and click 

the Table button in the Tables group. 

The table grid appears. Using the grid is the fastest way to insert a table. 

4.10 Insert Pictures Dialog Box 

4.11  Insert Pictures Dialog Box  after selecting Mount 

Rushmore 

       4.12  Inserting a table using the table grid 
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3.  Move the pointer around in the grid until the number of rows and columns you want to use 

have been selected. Then, click the mouse button. 

The table is inserted on to the slide and the DESIGN and LAYOUT contextual tabs appear on 

the Ribbon under TABLE TOOLS. 
 

Tip: Don’t worry if you inserted too many or not enough columns and rows—you can 
always add or delete them later. 
 

Other Way to Insert a Table: 

Click the INSERT tab on the Ribbon, click the Table button in the Tables group, and select 

Insert Table from the menu. Specify the number of rows and columns you want the table to 

have and click OK. 

 
4.8.2 Add text to a table 

 
Adding text to a table is extremely easy... 
 
1.  Click the cell you want to add text to. 
 
A blinking cursor appears inside the cell, indicating that the cell is ready to accept ext. 
2.  Type your text. 

 

 

  4.8.3 Working with Table 
 
Working with tables includes moving around the table, selecting row(s), column(s), cell(s) and 
deleting row(s), deleting column(s) and cell(s). 

 
4.8.3.1 Move around in a table 

There are several ways to move between cells in a table: 

o Press <Tab> to move forward one field or cell, or press <Shift>+<Tab> to move  

                    backward one field or cell. 

o Use the arrow keys on the keyboard. 

 

 4.8.3.2 Select a row 

1.  Position the insertion point anywhere in the row you want to select     

     and   click the LAYOUT tab on the Ribbon under TABLE TOOLS. 

2.  Click the Select button in the Table group and click Select Row     
                   from the menu. 

 
The row changes color, indicating that it is selected. 

 
Other Way to Select a Row: 
Point to the left or right of the row, until a tiny black arrow (     or     ) appears.  

 
4.8.3.3 Select a column 

1.  Position the insertion point anywhere in the column you want to select and click the  
                LAYOUT tab on the Ribbon under TABLETOOLS. 

 
2.  Click the Select button in the Table group and click Select Column from the menu. 

 
The column changes color, indicating that it is selected. 

 
Other Ways to Select a Column: 
Point to the top or bottom of the column, until a tiny black arrow( or ) appears. Click 

the mouse button. 
 
4.8.3.4  Select the entire table 

1.  Click  anywhere inside the table and click the LAYOUT tab on the   
     Ribbon under  TABLE  TOOLS. 
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2.  Click the Select button in the Table group and click Select Table from   
                   the menu. 

The table is selected. 
 

Other Way to Select the Entire Table: 
Right-click the table and 

click Select Table from the contextual 
menu, or click the  outermost 
perimeter of the table. 

 
4.8.3.5 Delete the contents of a cell 

Deleting the contents of a cell is 

extremely easy… 

 Select the cell contents you wish 

to delete and press 

the<Delete>key. 

 

4.8.3.6 Delete a Table 
 

If you decide you don’t want a table 
after all, delete it. 

 
  Select the table and press the 

<Delete> key. 
4.8.3.7 Adjusting Column Width and Row Height 

 
As you enter information into a table, you will quickly discover that some of your rows and 

columns need to be resized.  
4. 8.3.7.1  Adjust column width 

 
When a column is not wide enough to properly display the information it contains, adjust the width 
of the column. 

1.  Select the column(s) that you wish to adjust and click the LAYOUT tab on the Ribbon 
under TABLE TOOLS. 
2.  Specify the column width in the Width textbox in the Cell Size group. 

 
The column is resized. 

 
Other Way to Change Column Width: Click and drag the column’s right border. 

 
4.8.3.7.2  Adjust row height 

 
You will seldom need to adjust a row’s height because, unless you specify otherwise,   

          rows automatically expand to accommodate any text that you enter. 
 

1.  Select the row(s) that you wish to adjust and click the LAYOUT tab on the Ribbon under  
              Table Tools. 

2.  Specify the row height in the Height text box in the Cell Size  group. 
The row is resized. 

 
Other Way to Adjust Row Height: 
Click and drag the row’s bottom border up or down. 

 
Tip: 

 
You can distribute columns and rows evenly so that they are the same width or height. 

To do this, select the columns or rows that you wish to distribute and click the LAYOUT tab on 
the Ribbon under TABLE TOOLS. Click the Distribute Columns or Distribute Rows button in 
the Cell Size group. 

4.8.3.8  Inserting Rows and Columns 
 

You can make a table larger or smaller by inserting or deleting rows and columns.  
 

4.8.3.8.1 Insert a row 

 

4.13  Changing Column Width  
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1.  Position your insertion point anywhere in the row above or below where you want  to 
insert the new row. 

2.  Click the LAYOUT tab on the Ribbon under TABLE TOOLS and click the Insert  
Above or Insert Below button in the Rows & Columns group. 
 

The new row is inserted into the table. 
 

Other Way to Insert a Row: 
Right click the row above or below where you want to insert the new row, point to  

         Insert on the Mini Toolbar, and select an option from the submenu. 
 

4.8.3.8.2 Insert a column 

 
1.  Position your insertion point anywhere in the column to the left or right of where you 

want to insert the new column. 

2.  Click the LAYOUT tab on the Ribbon under TABLE TOOLS and click the Insert Left 

or Insert Right button in the Rows & Columns group. 

 

The new column is inserted into the table. 

 

Other Ways to Insert a Column: 

Right-click the column to the left or right of where you want to insert the new column, 

click Insert on the Mini Tool bar, and select an option from the submenu. 

 
4.8.3.9 Deleting  row(s) or column(s) 
 

1.  Position the insertion point anywhere in the row or column you wish to delete and click 

the LAYOUT tab on the Ribbon under TABLE TOOLS. 

2.  Click the Delete button in the Rows & Columns group and select an option from the 

menu. 

The row or column is deleted. 

Other Way to Delete a Row or Column: 

Right-click a cell in the row or column you wish to delete and select Delete 

from the Mini Toolbar and make a selection from the list. 

 
4.8.3.10  Merging and Splitting  

            Cells 

             You can adjust the number of cells   that appear in a table by merging  and splitting                   

cells. 

4.8.3.10.1 Merge cells 

The Merge Cells command combines, or 

merges, several smaller cells into a single larger 

cell. 

 1.  Select the cells that you want to merge. 

   2.  Click the LAYOUT tab on the Ribbon 

under TABLE  TOOLS and click the Merge 

Cells button in the Merge group. 

 

The selected cells are merged into a 

single cell. 

 

Other way to Merge Cells: 

Select the cells you want to merge, 

right-click the selected cells, and select 

Merge Cells from the contextual menu. 

 

4.14  Merging Cells 
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4.8.3.10.2 Split a cell 

 

 You can also break, or split,a cell into several smaller cells using the Split Cells  

  command. 

1.  Select the cell that you want to   

              split. 

     2. Click the LAYOUT tab on the  

          Ribbon under TABLE TOOLS  

         and click the Split Cells  

         button in the Merge group. 

The Split Cells dialog box  appears. 

3.  Specify how you want to split the                   

cell and click OK. 

The selected cell is split into several smaller cells. 

 

Other Way to Split a Cell: 

Right-click the cell you want to split and select Split Cells from the contextual  menu 

. 

4.9  Inserting a Chart 

Like the idiom “a picture is worth a thousand 

words”, a chart is often much better at presenting 

information than hard to read numbers in a table. This 

lesson explains how to insert a chart in Microsoft 

PowerPoint. 

1.  Navigate to the slide where you want to insert the 

chart. 

2.  Click the INSERT tab on the Ribbon and click the 

Chart button in the Illustrations group. 

The Insert Chart dialog box appears. 

3.  Select a chart type from the list, and then select a 

chart sub-type. Click OK. 

 

The chart is inserted onto the slide, and an Excel 

2013 worksheet opens in a new window. 

 

 Tip: If you don’t haveOfficeExcel2013 installed, a 

Microsoft Graph datasheet appears instead of an 

Excel worksheet. You can use Microsoft Graph the same as you would Excel, you just don’t 
have as many options. 

4.16  Inserting Chart  

       4.15  Splitting Cells 
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                  4.18  Common Chart Types 

 

4.9.1 Inserting Chart Data 

After you insert a chart, you need to 
replace the sample data in the Excel   
worksheet with  your own information. 
1.  Click the cell you want to add text to.  
2.  Type your text. 

The sample data is replaced with your own, 
and the chart updates to  
         reflect your changes. 

3.  When you’re finished entering data, click the 
Close button in the Excel  
              window. 

Excel closes and you return to the 
PowerPoint window. 
 

Tips: 
 

 To insert more rows and columns of 
data in the Excel worksheet, click and drag the lower corner of the cell range. 

 To edit a chart’s data, select the chart, click the DESIGN tab on the Ribbon, and  
click the Edit Data button in the Data group to open the Excel worksheet. 

 

4.17  Inserting Chart  by Place Holder 
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4.9.2 Resizing and Moving a Chart 
 

When you create a chart, it is embedded in the presentation and appears in a frame. 
Sometimes your chart might be too large, or positioned in the wrong spot on a slide. Luckily, 
you can resize or move a chart to meet your needs. 
            
 4.9.2.1 Resize a chart 
 

Make an object larger or smaller by resizing it. 

 
1.  Click the chart to select it. 

 
Eight sizing handles appear along the frame  

         of the chart, as shown in Figure 4.18. 
2.  Click and drag one of the chart’s sizing   

              handles. 
 

A faint outline appears as you drag, allowing   
you to preview the size of the chart. 
 

Tip: To maintain the chart’s proportions 
while resizing, hold down the<Shift> key as you 
drag. 
3.  Release the mouse button. 

 
The chart is resized. 

 
Other Way to Resize a Chart:  
Click the FORMAT tab on the Ribbon under CHART TOOLS, and use the Height 

and Width 
Fields in the Size group. 

4.9.2.2 Move a Chart 
 

By simply clicking and dragging with the mouse along the border of the  chart, you 

can  move a chart to a new location on the slide. 

1.  Click the chart’s border to select it, and drag the frame of the chart. 

A faint outline appears as you drag, allowing you to preview the location  

        of the chart. 

2.  Release the mouse button when the chart 

is positioned where you  

         want it. 

4.9.3  Changing Chart Type 

Different types of charts are better for presenting 

different types of information. For example, a 

column chart is great for comparing values of 

different items, but not for illustrating trends or 

relationships. If you find that a chart you’ve created 

isn’t the best fit for your data, you can switch to a 

different chart type. 

     1.  Select the chart. 

2.  Under CHART TOOLS on the Ribbon, 

click the DESIGN tab and click the Change 

Chart Type button in the Type group. 
 

The Change Chart Type dialog box appears. 

 
3.  Select a chart type from the list, and then select a chart sub-type. Click OK. 

 
The chart type is changed. 

 
Other Way to Change Chart Type: 
Right-click the chart frame and select Change Chart Type from the contextual 

menu. Select a new chart type and click OK. 

4.19 Resizing Chart 

4.20  Changing Chart Type 
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4.9.4 Formatting a Chart 
 

PowerPoint 2013 has a variety of built-in chart 

layouts and styles that allow you to format your charts 

with the click of a button. 

4.9.4.1 Change chart layout 

 

Built-in chart layouts allow you to quickly adjust 

the overall layout of your chart with different 

combinations of titles, objects, and chart orientations. 

1.  Select the chart and click the DESIGN tab on 

the Ribbon under CHART TOOLS. 

2.  Selecta layout from the Quick Layouts in the 

Chart Layouts group or use the Add Chart Elements 

button to change the layout of certain individual chart 

elements. 

The selected layout is applied to the chart. 

4.9.4.2 Change chart style 
 

Changing the visual style of a chart is an easy way to spice up  its appearance. A visual 

style is a set of different formatting commands that can be applied to a chart in a single step. 

1.  Select the chart and click the DESIGN tab on the Ribbon under CHART      

             TOOLS. 

2.  Selecta style from the Chart Styles group. 

 

The selected style is applied to the chart. 

 Tip: To view all the available styles, click the More button( ) in the Chart Styles group to 
display all the Chart Styles available. 
 

4.10 Inserting Audio 

Adding audio to a presentation is a great way to liven it up. There are two ways to insert 

audio: inserting an audio file or searching the Online for a sound. 

 
Insert audio you have on file 

 
To use your own audio files that you have saved on your computer, follow these 

instructions. 

  
1.  Click the INSERT tab on the Ribbon and  click the Audio  button list arrow in the        

Media group.  
 

A list of options appears. 

 
2.  Select Audio on my PC. 

 
The Insert Audio dialog box appears. 

 3.  Navigate to the file you want to insert. 

 4.  Select the file you want to insert and click 
Insert. 

 
An audio icon appears in the middle of the 

slide. You can move the icon to a less noticeable 
location. 

 
5.  If desired, click and drag the audio icon 

to a different location on the slide. 
Inserting Video from a File 

Options for inserting video in toy our slides have greatly improvedinPowerPoint2013. 

4.21  Changing Chart Style 

4.22 Inserting Audio Dialog Box 
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4.11 Insert a video file 

 
Videos that are inserted from a file are embedded directly into the Power Point presentation 

so you no longer have to make sure your video files are in the correct location on your hard drive. 

 
1.  Click the INSERT tab on the Ribbon 

and click the Video button list arrow in the 
Media group. 

 
A list of options appears. 

 
2.  Select one of the following options: 

 
Video on My PC: The Insert 

Video dialog box appears. Navigate to 
the video file that you want to insert 
and click Insert. 

 
Online Video: The Online 

Video dialog box appears. Type the 
key word for the video you want to 
insert, scroll through the available 
options and make your selection. Click 
Insert. 

 
The video appears in the slide. 
  

4.12  Insert a hyperlink 
1. Select Slide in Normal View. 
2. Highlight the located in the text box at the  

                           bottom of the slide. 
3. In the Insert tab  are at the top of the   

                      window,  click the Hyperlink button. 
 

4. In the Insert Hyperlink window, click  

                          Existing  File or Web Page on the left hand side of  

  the window. 

5. In the Address: field, type http://www.odisha.gov.in 
 

6. Click the OK button. 
 

7. Click in an empty area of the slide to deselect the text box. 

  
                                                                         Figure 4.25  Hyperlink Dialog box 

Views of Slides in a presentation 

4.23 Inserting Video Dialog Box 

Figure 4.24 Hyperlink 
Option in Inert menu 

http://www.odisha.gov.in/
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5.1 Why Different views 

You can view your PowerPoint slides 

in a variety of ways depending on the task at 

hand. Some views are helpful when you're 

creating your presentation, and some are 

most helpful for delivering your presentation. 

You can find the different PowerPoint 

view options on the View tab, as shown in 

Figure 5.1 

5.1.1  Views for creating your 

presentation Normal view 

You can get to Normal view from the task 

bar  at the bottom of the slide window, or 

from the View tab on the ribbon. 

Normal view is where you’ll work most frequently to 
create your slides. It is the default view in 

PowerPoint. Below, Normal view displays slide 

thumbnails on the left, a large window showing the 

current slide, and a section below the current slide 

where you can type your speaker notes for that 

slide. 

5.1.2 Outline view 

You can get to Outline view from 

the View tab on the ribbon. 

NOTE    In PowerPoint 2013 and later, you can no 

longer get to Outline view from Normal view. You'll 

need to get to it from the View tab. 

Use Outline view to create an outline or story board for your presentation. It displays only 

the text on your slides. 

 

5.1 Different view buttons  

5.2 Normal View 

5.3 OutLine  View 
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5.1.3 Slide Sorter view 

You can get to Slide 

Sorter view from the task bar  at 

the bottom of the slide window, or from 

the View tab on the ribbon. 

Slide Sorter view (below) 

displays all the slides in your 

presentation in horizontally 

sequenced, thumbnails. Slide show 

view is helpful if you need to 

reorganize your slides – you can just 

click and drag your slides to a new 

location, or add sections to organize your  slides into 

meaningful groups. 

5.1.4  Notes Page view 

You can show or hide your speakers 

notes with the Notes button  at the 

bottom of the slide window, or you can get 

to Notes Page view from the View tab on the 

ribbon. 

The Notes pane is located beneath the 

slide window. You can print your notes or include 

the notes in a presentation that you send to the 

audience, or just use them as cues for yourself 

while you're presenting. 

5.1.5 Reading view 

You can get to Reading view from the 

task bar  at the bottom of the slide window.. 

Most people reviewing a PowerPoint presentation without a presenter will want to use Reading 

view. It displays the presentation in a full screen like Slide Show view, and it includes a few simple 

controls to make it easy to flip through the slides. 

 

5.2 Views for delivering and viewing a presentation 

5.2.1 Slide Show view 

You can get to SlideShow view from the task bar  at the bottom of the slide window.. 

Use Slide Show view to deliver your presentation to your audience. Slide Show view 

occupies the full computer screen, exactly the way your presentation will look on a big screen when 

your audience sees it. 

Alternatively, one can show the Slide Show view just by pressing F5 key 

 

5.2.2 Presenter view 

To get to Presenter view, in Slide Show view, in the lower left 

corner of the screen, click , and then click Show Presenter View (as 

shown on right).  

Use Presenter view to view your notes while delivering your 

presentation. In Presenter view, your audience cannot see your notes.  

 

5.3  Importance of  Slide Master 

Using the Slide Master is the fastest and easiest way to set up 

Figure 5.4 Slide Sorter View 

Figure 5.5 Notes Page View 

Figure 5.6  Presenter view Option 
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the appearance of all the slides in a presentation. 

The Slide Master controls all aspects of a slide’s appearance, including its background color, 

font style, and any recurring text or pictures. Any changes you make the Slide Master automatically 

affect all the slides in the presentation; for example, adding a candy-striped background to the 

Master adds a candy-striped background to every single one of your slides. 

 

5.3.1 Working with Master Slide 

1.   Click the VIEW tab on the Ribbon and 

click the Slide Master button in the Master 

Views group. 

 

The Slide Master appears, as well as 

nine Layout Masters. To adjust only 

those slides that use a certain layout—
for example, the title slide—use a Layout 

Master. 

2.   Click the Slide Master or the appropriate 

Layout Master. 

 

Each Master includes placeholders for 

text and objects, as well as three 

additional placeholders at the bottom for 

the date, footer text, and slide number. 

 

3.   Make any desired changes to the 

Master, including: 

 

 Adjusting the font type and size: Use the commands on the Home tab to format text and 

paragraphs. 

 

 Formatting the background: Use the commands on the Slide Master tab to adjust the 

background, theme, or layout. 

 

 Adding graphical objects: Use the commands on the Insert tab to insert pictures and 

graphics such as a company logo. 

 

 Inserting or removing placeholders: To remove a placeholder, select it and press 

<Delete>. To insert a placeholder, click the Insert Placeholder list arrow in the Master 

Layout group on the SLIDE MASTER tab and select a placeholder from the list. 

 

4.   Click the Close Master View button in the Close group on the SLIDE MASTER tab when 

you’re finished. 

 
 
 
 
 
 
 
 

Figure 5-7 Master Slide 
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Making Your Presentation more Attractive 
1 Insert and edit animations  

PowerPoint’s animation feature is now 
much easier to use. It has its own tab on the 
Ribbon, and many new animation effects 
have been added. 

 
An animation effect is a preset visual 

effect that can be applied to the text or 
objects on a slide. See Table 6-1: 
Descriptions of Animation Effects to view 
specifics about certain effects. 
 
6.1.1 Apply an animation effect 

1.   Select the text or object that you 
want    to animate. 

 
2.   Click the ANIMATIONS tab on the 

Ribbon and 
click the More button on the Animation gallery in the 
Animation group. 

 
The Animation gallery appears. 

 
3.   Select an animation effect from the list. 

 
The preset animation is applied to the text or object and a preview of the effect is 

displayed. A number appears next to the object showing the order in which the animation will 
be displayed. 

 
  Tip: To see more animation effects, click More Entrance Effects, More 

Emphasis Effects, More Exit Effects, or More Motion Paths in the Animation gallery. 
 

Now you can add an effect option. An effect option allows you to change the way an 
animation effect behaves. For example, if you use the Fly In animation effect, you can choose 
the direction from which the object or text flies in. 

 
4.   (Optional) Click the Effect Options button in the Animation group and  
select an option. 

 
The selected effect option is applied and a preview is displayed. 

 
6.1.2  Trigger an animation 

 
By default, all animated objects will appear on your slide with successive clicks of the mouse. 
Triggers will only show animated objects when a specific event occurs. 

 
1.   Select the effect you wish to modify. 

 
2.   Click the ANIMATIONS tab on the Ribbon and click the Trigger button in the Advanced 

Animation group. 
 

A list of options appears. 
 On Click Of: Starts the  animation effect when you click the specified object on the slide. 

 
 On Bookmark: Starts the animation effect when a video or audio clip hits a specific 

bookmark. 
 

3.   Select the trigger you wish to use. 
 

The trigger is assigned to the animation. 
 

 Trap: If the triggering event does not 
occur, the object will not animate. 

 
6.2. Modifying Animation Effects 

Table 6.1  Animation Effects 
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You can modify animation effects to further meet your needs. This lesson will show you how to 
adjust the speed and starting point of an animation effect and how to remove an animation effect if 
you decide you don’t like it. 

 
6.2.1 Adjust when an animation starts 

 
By default, animations start “on click,” which means you have to click the mouse each time you 
want to run an animation effect during a slide show. However, you can adjust this to meet your 
needs. 

 
1.   Select the object that has the effect that you wish 

to modify. 
 

2.   Click the ANIMATIONS tab on the Ribbon and click the Start list arrow in the Timing group. 
 

A list of options appears: 
 

 On Click: Starts the animation effect when you click the slide. 
 

 With Previous: Starts the animation effect at the same time as the previous effect in the list 
(i.e., one click executes two animation effects). 

 
 After Previous: Starts the effect immediately after the previous effect. Or, if this is the first 

or only animation effect on the slide, selecting this option will start the effect as soon as the 
slide appears. 

 
3.   Select an option from the list. 

 
The effect is applied. 

 
6.2.2 Adjust the duration of an animation 
effect 

 
Depending on the type of presentation you’re 

creating, you might want certain animation 

effects to play longer than others. It’s easy to 

change this to meet your needs. 

 
1.   Select the effect that you wish to modify. 

 
2.   Click the ANIMATIONS tab on the Ribbon and 

click the Duration up and down arrows in the Timing group. 
 

The animation duration is changed. 
 

  Tip: The longer the duration, the slower the animation effect will play; the shorter the 
duration, the faster the animation will play. 

6.2.3 Delay the start of an animation effect 
 

If you don’t want an animation to start right away, you can delay its start. This can be particularly 
useful when spacing out multiple animation effects on the same slide. 
1.   Select effect that you wish to modify. 
2.   Click the ANIMATIONS tab on the Ribbon and click the Delay arrows in the Timing group. 

 
The animation delay is set. 

 
6.2.4  Re-order animation effects 

 
If you want to adjust the order in which animation effects play, you can simply re-order them. 

 
1.   Select the effect you wish to re-order. 

 
2.   Click the ANIMATIONS tab on the Ribbon and click the Move Earlier or Move Later button in 

the Timing group. 
 

The number next to the animation changes accordingly. 

6.2  Modify Animation Effect 

Table 6.3  Speed of Animation Effects 
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6.3 Remove an animation effect 

 
It’s easy to remove an animation if you decide you don’t like it. 

 
1.   Select the effect that you wish to remove. 

 
2.   Click the ANIMATIONS tab on the Ribbon and click the More button in the Animation group. 

 
A list of animation options appears. 

 
3.   Select None. 

 
The animation effect is removed. 

 
  Other Ways to Remove an Animation Effect: Click the Animation Pane button in the 
Advanced Animation group on the ANIIMATIONS tab. Select the effect you want to remove 
from the list, click the effect’s list arrow, and click Remove. 

 
6.4 Customizing Animation Effects 

 
You can further customize animation effects from the Animation Pane. The Animation Pane 

gives you a little more control over how effects behave on the slide, including animation order, 

effect durations, effect options, and timing. 

Customize effect options 
 

Effect options may be adjusted beyond 

the options that are presented on the 

Ribbon. For example, you can adjust start 

and end settings as well as add 

enhancements, like sound effects. 

 

1.   Click the ANIMATIONS tab on the 

Ribbon and click the Animation Pane 

button in the Advanced Animation 

group. 

 

The Animation Pane appears. It 

displays each of the animation effects 

on a specific slide in the order in which 

they were added. 

2.   Select the effect that you wish to 

customize. 

3.   Click the animation’s list arrow and 

select Effect Options from the list. 

The Animation Effect dialog box 

appears with the Effect tab displayed. 

4.   Customize the animation effect using 

the options under the Settings and 

Enhancement headings and click OK. 

The new settings are applied and a 

preview appears. 

 

 

6.4.1 Customize animation timing 

Much like effect options, you can also customize  timing from the Animation Pane. You can 
change settings, set triggers, or set an effect to repeat. 

 
1.   Click the ANIMATIONS tab on the Ribbon and click the Animation Pane button in the 

Figure 6.4 The Animation Pane 
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Advanced Animation group. 
 
The Animation Pane appears. 
2. Select the effect that you wish to customize. 
3.   Click the animation’s list arrow and select Timing from 
the list. 
 
The Animation Effect dialog box appears with the Timing tab 
displayed. 

 
4.   Change the timing options and click OK. 

 
The new settings are applied and a preview appears. 

 
  Other Ways to Customize Effect Timings:  Select 
the effect in the Animation Pane and click and drag 

the border of the green timeline box next to the 
effect, either left or right to shorten or lengthen the 
time. 

 
6.4.2  Copying Animation Effects 

 
If you find yourself applying the same animations over and over again, then you should familiarize 

yourself with the Animation Painter tool. The Animation Painter copies how an object is animated 

and lets you apply that animation to other objects. 

1.   Select the object with the animation you want to copy. 
 

The Animation Painter will copy all of the animation attributes of the selected object. 

 
2.  Click the ANIMATIONS tab on the Ribbon and click the Animation Painter button in the 

Advanced Animation group. 
 

The selected object’s animation is 

copied and the pointer changes 

from a  to a . 
 

  Tip: Single-click the 
Animation Painter button to 
apply copied formatting once. 
Double-click the Animation 
Painter button to apply copied 
animation multiple times. 

3.   C lick the        pointer on the 
object to which you want to apply 
the copied animation. 

 
The copied animation is applied. 

 
  Tip: If you double-clicked the 
Animation Painter button in 
Step 2, click the Animation 
Painter button again to 
deactivate it, or press <Esc>. 

 
6.5 Applying a Transition Effect 

 
The ability to apply transitions to slides has improved in PowerPoint 2013. Plus, some great 

new transition effects have been added. 
 

A transition is an animation that occurs when PowerPoint advances from one slide to the 
next during a slide show. 

 
6.5.1 To a single slide 

 

Figure 6.6 Animation Painter 

Figure 6.5  : The Timing tab of the 

animation style dialog box. Options may 

differ among the animation styles. 
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Follow these steps to apply a transition effect to a single slide. 

 
1.  Select the slide to which you want to add a 

transition effect. 

 

  Tip: To select multiple slides, hold down the 

<Shift> key as you select each slide. 

 

2.   Click the TRANSITIONS tab on the Ribbon 

and select a transition in the Transition to This 

Slide group. To see more transition options, 

click the More button on the Transition gallery. 

 

3.   Once selected, a small star appears on the left 

hand side of the slide in the Outline pane 

indicating that a transition effect has been 

applied to that slide. 

 

Now, you can add an Effect Option. An Effect 

Option allows you to change the way a 

transition effect behaves. For example, if you use the Push transition effect, you can choose 

whether the slide is pushed from the bottom, top, left, or right. 

 

4.   (Optional) Click the Effect Options button in the 

Transition to This Slide group and select an option. 

 

The transition effect is modified. 

 

 Trap: Try not to use too many different types of effects in the same presentation. Too many 

transition effects can distract your viewers rather than intrigue them. 

 
6.5.2 To all slides 

 
If you want to apply the same transition effect to all slides in a presentation, follow these steps. 

 
1.   Select one slide to which you want to add a transition effect. 

 
2.   Click the TRANSITIONS tab on the Ribbon and click the More button in the Transition to This 

Slide group. 
3.   Select a transition effect from the gallery. 

 
The Effect Options button activates. Now, you can add an effect option. 

 
4.   (Optional) Click the Effect Options button in the 

Transition to This Slide group and select an option. 
 

The transition effect is modified. 

 
5.   Click the Apply To All button in the Timing group. 

 
The transition effect is applied to all of the slides in the presentation. 

 
  Trap: Try not to use too many different types of effects in the same presentation. Too many 

transition effects can distract your viewers rather than intrigue them. 
 

 
  Another way to Apply a Transition to Multiple Slides: Hold down the <Shift> key and 

select all the slides you want to apply a transition to in the Outline pane. Click the 
TRANSITIONS tab on the Ribbon and select a Transition from the gallery in the Transition 

Figure 6.7 Click the More button in the Transition to 
This Slide group to display the Transitions gallery. 
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to This Slide group. 
 

6.6 Removing a transition 

 
1.   Select the slide from which you want to remove the transition effect. 

 
2.   Click the TRANSITIONS tab on the Ribbon and select None from the Transition gallery in the 

Transition to This Slide group. 
 

The transition is removed. 
 
6.7 Modifying a Transition Effect 

 
You can customize a transition effect to 
meet your needs, including adjusting 
its speed and adding sound. This 
lesson will show you how. 

 
6.7.1     Adjust transition speed 

 
Transitions can occur at any speed 

according to your personal and 
professional preference. 

 
1.   Navigate to the slide containing the 

transition effect you want to 

modify. 

2.   Click the TRANSITIONS tab on 

the Ribbon and click the Duration 

arrows in the Timing group to 

adjust the speed of the transition. 

 

The speed of the transition is 

adjusted. 

 

  Tip: To apply the selected 

speed to all slides, click the 

Apply To All button in the 

Timing group. 
 

 Trap: Make sure to preview your 
transition speeds before 
delivering your presentation in front of a live audience. You may find that some transition 
effects work best at different speeds. 

 
6.7.2     Add sound 

 
Adding sound to a transition effect is a fun way to grab audience attention. 

 
1.   Navigate to the slide containing the transition effect you want to modify. 
2.   Click the TRANSITIONS tab on the Ribbon and click the Sound list arrow in the Timing group. 

 
A list of sounds appears. 

3.   Select a sound from the list. 
 

  Tip: To use a sound that is saved on your computer, select Other Sound from the list. 
 

  Tip: To loop your sound effect until the next sound, select Loop Until Next Sound at the 
end of the list. 

 
 Trap: If you have your transition speed set to Fast, the sound will play fast as well. 

 
6.7.3 Remove a transition effect 

 

Figure 6.8  You can modify a transition effect by changing the 
duration or adding sounds 
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It’s easy to remove a transition effect if you decide you don’t like it. 

 
1.   Navigate to the slide containing the transition effect you want to remove. 

 
2.   Click the TRANSITIONS tab on the Ribbon and click the More button in the Transition to This 

Slide group. 
 

The Transitions gallery appears. 
3.   Select None from the gallery. 

 
The transition effect is removed. 

6.7.4 Remove a sound 
 

You can easily remove a sound from a transition. 
1.   Navigate to the slide containing the transition sound you want to remove. 

 
2.   Click the TRANSITIONS tab on the Ribbon and click the Sound list arrow in the Timing group. 

 
3.   Select [No Sound] from the list. 

 
The sound is removed. 

 
 Tip:  

 It’s a good idea to preview any transition speeds or sounds before you deliver your 
presentation in front of an audience. 

 
6.8 Previewing a Transition or Animation Effect 

 
 You should always preview your transition and animation effects before you deliver your 
presentation in front of an audience. 

 
1.   Navigate to the slide 

containing the transition 

or animations you want 

to preview. 

2.   Click the TRANSITIONS 

or ANIMATIONS tab on 

the Ribbon and click the 

Preview button in the 

Preview group. 

A preview of each effect 

on the slide appears. 

 

  Tip: During an 

animation preview, a 

tiny timer bar 

appears in the 

Animation Pane. You 

can use this timer to 

calculate how long it 

takes for your 

animations to play. 

 

  Other Ways to Preview an Animation: 

In the Animation pane, select the effect you want 

to preview and click the Play Selected button. 

 

Running and Controlling Slide Show 
7.1 Setting Up a Slide Show 

Figure 6.8  Previewing Animation 
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Before delivering a presentation in front of an audience, there are several things you should 

consider. 

 

7.1.1 Specify the show type 

1.    Click the SLIDE SHOW tab on the Ribbon and click the Set Up Slide Show button 

in the Set Up group. 

The Set Up Show dialog box appears. Under Show type, you have several options from 

which to choose: 

 

 Presented by a speaker: This 

is the typical full- screen slide show. You 

can advance the slides and animations 

manually, or you can set automatic 

timings.  

 Browsed by an individual: 

Runs the slide show in a standard 

window, with custom menus and 

commands for the viewer to use. 

 Browsed at a kiosk: Delivers 

the slide show as a self-running show 

that restarts at the end of the 

presentation. The viewer can click 

hyperlinks and action buttons but cannot 

modify the presentation. 

 

2.   Select the desired option and click OK to save your 

changes. 

 

7.1.2 Specify show options 
 

1.   Click the SLIDE SHOW tab on the Ribbon and click 

the Set Up Slide Show button in the Set Up group. 

The Set Up Show dialog box appears. Under Show 

options, you have several options from which to choose: 

 Loop continuously until ‘Esc’: Select this 

option if you are leaving the show unattended and want it 

to continuously repeat. 

 Show without narration: If you recorded 

narration but don’t want to use it, select this option. 

 Show without animation: Select this option to disable animations. This might be 

necessary for presentations being viewed on slower computers 

2. Select the desired option and click OK to save your changes. 

 

7.1.3 Specify which slides to include 

 

1.   Click the SLIDE SHOW tab on the Ribbon and click the Set Up Slide Show button in the Set 

Up group. 

The Set Up Show dialog box appears. Under Show slides, you have several options from 

which to choose: 

 All: Select this option to include all slides in the presentation (except for slides you’ve 

hidden). 

 From: Select this option to include a range of slides that you specify. 

 Custom show: Select this option to pick and choose any number or range of slides that you 

Figure 7-1 The Set Up Show dialog box 

Figure 7-2 Saved timings will 
appear underneath each slide in 

Slide Sorter view. 
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wish. 

2.   Select the desired option and click OK to save your changes. 

 

7.1.4 Specify how to advance slides 

 1.   Click the SLIDE SHOW tab on the Ribbon and click the Set Up Slide Show  

button in the Set Up group. 

The Set Up Show dialog box appears. Under Advance slides, you have two options 

from which to choose: 

 Manually: Selecting this option requires you to click the mouse or use the 

keyboard to advance slides. 

 Using timings, if present: Select this option to move slides forward 

automatically based on the timings you save when you rehearse. 

2.   Select the desired option and click OK to save your changes. 

 

7.2 Rehearsing Slide Show Timings 

When you deliver your presentation in front of an audience, you want to make sure that each 

slide is displayed for an adequate amount of time. Use PowerPoint’s Rehearse Timings feature to 

specify the amount of time between slides when you are rehearsing your presentation. 

1.   Click the SLIDE SHOW tab on the Ribbon and click the Rehearse Timings 

button in the Set Up group. 

The presentation opens in Slide Show 

view, and the Recording toolbar appears. 

 2.   Navigate through the presentation, 

leaving each slide displayed for the 

approximate length of time that you want 

it to be displayed during your 

presentation. 

When it reaches the length of time that 

you want, click the Next button on the 

Recording toolbar. 

 

  Tip: Keep in mind that PowerPoint is 

recording your every move, so don’t rush through your slides unless you want your viewers 

to be rushed,too. 

  Tip: If you mess up or want to restart the timing on a slide, click the Repeat button 

on the Recording toolbar. 

When you’re finished, a dialog box appears asking 

whether or not you want to save your timings. 

3.   Click Yes to save your timings or click No to discard 

them. 

If you chose to save your timings, your slides will 

automatically advance using those timings the next 

time you run the slide show. 

 

 Tips: 

 If you decide you want to run your presentation 

manually without timings, click the SLIDE SHOW 

tab on the Ribbon and click the Set Up Slide 

Show button in the Set Up group. Select Manually 

under Advance slides and click OK. 

 To redo your timings, simply run the Rehearse 

 Timings feature again. 

7.3  Working with Comments to a Slide 

Figure 7 3 The Recording toolbar. 
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7.3.1 Adding comments 

 Adding a comment to a slide is like sticking a Post-It note to it. You can use comments to 

add suggestions, notes, or reminders to a slide. 

1.   Navigate to the slide to which you want to add a comment. 

2.   If you want to attach the comment to a particular object on the slide (placeholder, image, etc.), 

click the object to select it. 

3.   Click the REVIEW tab on the Ribbon and click the 

New Comment button in the Comments group. A new comment box appears. 

4.   Type your comment. When you’re finished, click anywhere outside the comment box to 

deselect it. 

7.3.2 Edit a comment 

You can easily make changes to a comment simply by typing in any comment box. 

 Click in the comment box and edit the text as needed. 

7.3.3 Delete a comment 

Delete a comment when it is no longer needed. 

 Select the comment box and click the Delete 

Comment button in the Comments group of the 

Review tab on the Ribbon. 

  Other Ways to Delete a Comment: 

Right-click  the comment box and select Delete 

Comment  from the contextual menu. 

7.3.4 Hide or show comments 

If comments are distracting, you can temporarily 

hide them from view. 

 Click the REVIEW tab on the Ribbon and click the 

Show Comments button in the Comments group. 

 Click to check Comments Pane and Show Markup. 

 Tips: 

  Comments do not appear in Slide Show view or 

Slide Sorter view. 

 You can add more than one comment to text, an 

object, or a slide in a presentation. 

7.4 Hiding a Slide 

 If you don’t want a slide to be included in the final 

slide show, you can hide it from your audience. 

1.   Navigate to the slide you want to hide. 

2.   Click the SLIDE SHOW tab on the Ribbon and click 

the Hide Slide button in the Set Up group. 

The slide number is crossed out, indicating that the 

slide is hidden. 

  Other Ways to Hide/Unhide a Slide: 

Right-click the slide that you want to hide or unhide in the Outline pane, and select Hide 

Slide from the contextual menu. 

 Tip: 

To unhide a slide, repeat the steps listed above. 

Figure 7 4 Use the commands in the 

Comments group to insert, edit, and delete 

comments in a presentation. 

 

7.5 Show or Hide Button with Hiding  Slide in  
Slide Sorter View 
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Printing a Presentation 

 
8.1 Previewing and Printing a Presentation 

 

Once you have created a presentation, and your computer is connected to a printer, you can 

print a copy. It is basically the last part of the Presentation, if you want to get a hard copy. Before you 

do this, it’s a good idea to preview how it’s going to look. 

 Click the FILE tab and select Print. 

 

Notice that the print settings and a preview of the document appear together, with print 

settings on the left and a 

preview on the right. 

 

  Tip: Use the scroll bar 

or the page navigation 

controls below the 

preview to view other 

pages in the document. 

 

  Other Ways to 

Preview and Print: 

Press <Ctrl> + <P>. 

 

After previewing the 

document, you can specify 

printing options, such as which pages or the number of copies to print. 

 

  Specify printing options and click the Print button. 

 

The document is sent to the printer. 

 

8.1.1 Printing slides 

•   Save the presentation before printing. 

•   Click on the File tab in the top left corner of the 

window. 

•   Select Print 

•   In the Print window, maintain Print All Slides 

under settings. 

 

•   Click the down arrow next to Color/Grayscale: 

under settings. 

 

 Select Grayscale. 

 Select Frame Slides in the drop down 

menu under Full Page Slides. 

 Click the Print button. 

 

8.1.2 Print handouts 

 Click on the File tab in the top left 
corner of the window.  

 Select Print. 

Figure 8 1  Print Options 

Figure 8 2 Print settings 
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 In the Print window, click the up arrow for Number of Copies to change the number 
to 2. 

 Click on the down arrow next to Full Page 
Slides under settings. 

 Select 2 Slides under Handouts. 

 Click the down arrow next to Color/Grayscale: 

under settings. 

 Select Pure Black and White. 

 Select Frame Slides in the drop down menu 

under Full Page Slides.              

 Click the Print button 

  

8.1.3 Print speaker  notes. 

• Select Print 

•  In the Print window, click on the down arrow next 

to   

  Full Page Slides under setting 

• Select Notes Pages.  

• Click the down arrow next to Color/Grayscale/Pure Black 

and White: under settings. 

• Select Pure Black and White. 

• Select Frame Slides in the drop down menu under Full 

Page Slides/Notes Pages. 

•   Click the Print button. 

 

8.1.4 Print multiple copies of one slide 

•   Click on the File tab in the top left corner of the window. 

•   Select Print. 

•   In the Print All Slides drop down menu of the Print 

window, select Custom Range. 

•   Type 4 in the Slides window. 

•   Click the up arrow for Number of Copies to change the 

number to 3. 

8.2 Previewing of the Presentation 

It is always advisable and a good practice to view your presentation before it is printing. One 

can view how the presentation will be looked after printing by Preview option. 

After providing necessary print options, You can Preview your presentation from File->Print-

>Preview . 

You can exit from preview option by using Close Print Preview.  

 

 
 
 
 
 

INTRODUCTION TO INTERNET 

Figure 8 3 Setting for Handouts 

Figure 8 3 Setting Color for handout  
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9.1. NETWORK 

 
9.1.1  Introduction 

A network can be defined as a group of computers and other devices connected in some 

ways so as to be able to exchange data. Each of the devices on the network can be thought of as a 

node; each node has a unique address. Addresses are numeric quantities that are easy for 

computers to work with, but not for humans to remember. Example: 204.160.241.98 some networks 

also provide names that humans can more easily remember than numbers. 

 
9.1.2 Types of Networks 
There are several different types of computer networks. Computer networks can be characterized by 

their size as well as their purpose. 

The size of a network can be expressed by the geographic area they occupy and the number of 

computers that are part of the network. Networks can cover anything from a handful of devices within 

a single room to millions of devices spread across the entire globe. 

Some of the different networks based on size are: 

 Personal area network, or PAN 

 Local area network, or LAN 

 Metropolitan area network, or MAN 

 Wide area network, or WAN 

In terms of purpose, many networks can be considered general purpose, which means they are used 

for everything from sending files to a printer to accessing the Internet. Some types of networks, 

however, serve a very particular purpose. Some of the different networks based on their main 

purpose are: 

 
9.1.2.1 Personal Area Network 
 

A personal area network, or PAN, is a computer network organized around an individual person 

within a single building. This could be inside a small office or residence. A typical PAN would include 

one or more computers, telephones, peripheral devices, video game 

consoles and other personal entertainment devices. 

 

If multiple individuals use the same network within a residence, the 

network is sometimes referred to as a home area network, or HAN. In 

a very typical setup, a residence will have a single wired Internet 

connection connected to a modem. This modem then provides both 

wired and wireless connections for multiple devices. The network is 

typically managed from a single computer but can be accessed from any device. 

 

This type of network provides great flexibility. For example, it allows you to: 

 

Send a document to the printer in the office upstairs while you are sitting on the couch with your 

laptop. 

Upload the photo from your cell phone to your desktop computer. 

Watch movies from an online streaming service to your TV. 

If this sounds familiar to you, you likely have a PAN in your house without having called it by its 

name. 

 
9.1.2.2 Local Area Network 

A local area network, or LAN, consists of a computer network at a single site, typically an individual 

office building. A LAN is very useful for sharing resources, such as data storage and printers. LANs 
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can be built with relatively inexpensive hardware, such as hubs, network adapters and Ethernet 

cables. 

 

The smallest LAN may only use two computers, while larger LANs can accommodate thousands of 

computers. A LAN typically relies mostly on wired connections for increased speed and security, but 

wireless connections can also be part of a LAN. High speed and relatively low cost are the defining 

characteristics of LANs. 

 

LANs are typically used for single sites where people need to share resources among themselves but 

not with the rest of the outside world. Think of an office 

building where everybody should be able to access 

files on a central server or be able to print a document 

to one or more central printers. Those tasks should be 

easy for everybody working in the same office, but you 

would not want somebody just walking outside to be 

able to send a document to the printer from their cell 

phone! If a local area network, or LAN, is entirely 

wireless, it is referred to as a wireless local area 

network, or WLAN. 

Ethernet, Token Ring, and Fibber 

Distributed Data Interconnect (FDDI). 

Ethernet LANs: based on a bus topology and broadcast communication 

Token ring LANs: based on ring topology 

9.1.2.3 Metropolitan Area Network 
A metropolitan area network, or MAN, consists of a computer network 
across an entire city, college campus or small region. A MAN is larger 
than a LAN, which is typically limited to a single building or site. 
Depending on the configuration, this type of network can cover an area 
from several miles to tens of miles. A MAN is often used to connect 
several LANs together to form a bigger network. When this type of 
network is specifically designed for a college campus, it is sometimes 
referred to as a campus area network, or CAN. 
9.1.2.4 Wide Area Network 
A wide area network, or WAN, occupies a very large area, 
such as an entire country or the entire world. A WAN can 
contain multiple smaller networks, such as LANs or MANs. 
The Internet is the best-known example of a public WAN. 
-Cover cities, countries, and continents. 
-Based on packet switching technology 
-Examples of WAN technology: Asynchronous Transfer 
Mode (ATM), 
Integrated Services Digital Network (ISDN) 
 
9.2 Private Networks 
One of the benefits of networks like PAN and LAN is that they can be kept entirely private by 
restricting some communications to the connections within the network. This means that those 
communications never go over the Internet. 
 
For example, using a LAN, an employee is able to 
establish a fast and secure connection to a company 
database without encryption since none of the 
communications between the employee's computer and 
the database on the server leave the LAN. But what 
happens if the same employee wants to use the 
database from a remote location? What you need is a 
private network. 
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9.3. What is network topology 

Network Topology refers to layout of a network and how different nodes in a network are connected 
to each other and how they communicate. Topologies are either physical (the physical layout of 
devices on a network) or logical (the way that the signals act on the network media, or the way that 
the data passes through the network from one device to the next). There are five of the most 
common network topologies.  
1. Mesh Topology: In a mesh network, devices are connected with many redundant 
interconnections between network nodes. In a true mesh topology every node has a connection to 
every other node in the network. There are two types of mesh topologies: 

1.1 Full mesh topology: occurs when every node has a circuit 
connecting it to every other node in a network. Full mesh is very expensive to 
implement but yields the greatest amount of redundancy, so in the event that 
one of those nodes fails, network traffic can be directed to any of the other 
nodes. Full mesh is usually reserved for backbone networks. 

1.2 Partial mesh topology: is less expensive to implement and yields 
less redundancy than full mesh topology. With partial mesh, some nodes are 
organized in a full mesh scheme but others are only connected to one or two in the network. Partial 
mesh topology is commonly found in peripheral networks connected to a full meshed backbone. 
 
2. Star Topology: In a star network devices are connected to a central computer, 
called a hub. Nodes communicate across the network by passing data through the 
hub. 
Main Advantage: In a star network, one malfunctioning node doesn't affect the 
rest of the network. 
Main Disadvantage: If the central computer fails, the entire network becomes 
unusable. 
 
3. Bus Topology: In networking a bus is the central cable -- the main wire -- that connects all 
devices on a local-area network (LAN). It is also called the backbone. This is often used to describe 
the main network connections composing the Internet.  Bus networks are relatively inexpensive and 
easy to install for small networks. Ethernet 
systems use a bus topology. 

Main Advantage:  It's easy to connect a 
computer or device and typically it requires less 
cable than a star topology. 

Main Disadvantage: The entire network shuts 
down if there is a break in the main wire and it can be difficult to identify the problem if the network 
shuts down. 
 
4. Ring Topology: A local-area network (LAN) whose topology is a ring. That is, 
all of the nodes are connected in a closed loop. Messages travel around the 

ring, with each node reading those messages addressed to it.  

Main Advantage: One main advantage to a ring network is that it can span 
larger distances than other types of networks, such as bus networks, because 
each node regenerates messages as they pass through it. 

  
5. Tree Topology: This is a "hybrid" topology that combines characteristics of 
linear bus and star topologies. In a tree network, groups of 
star-configured networks are connected to a linear bus 
backbone cable. 

Main Advantage: A Tree topology is a good choice for 
large computer networks as the tree topology "divides" the 
whole network into parts that are more easily manageable. 
Main Disadvantage: The entire network depends on a 
central hub and a failure of the central hub can cripple the 
whole network. 
 
WHAT IS INTERNET 

http://www.webopedia.com/TERM/T/topology.html
http://www.webopedia.com/TERM/N/network.htm
http://www.webopedia.com/TERM/N/node.htm
http://www.webopedia.com/TERM/L/local_area_network_LAN.html
http://www.webopedia.com/TERM/B/backbone.html
http://www.webopedia.com/TERM/E/Ethernet.html
http://www.webopedia.com/TERM/L/local_area_network_LAN.html
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The computer network, Internet, was born in 
1969. It was created by a group of researchers 
from the Defense Department of the United 
States to establish a Communication system 
with other agencies of the Government. The 
fear that an attack could destroy all the 
information stored in the same place obliged 
them to avoid storing the information in one 
single central computer and, instead, store it in 

multiple interconnected computers. It is currently 
estimated that Internet groups 25,000 networks, 
that communicate among themselves through 
telephone line, fiber optics or via satellite Internet is 
a global network of many computers connected via 
telecommunication networks. The computers 
communicate using a set of protocols called TCP/IP 
(Transmission Control Protocol/Internet Protocol). 
Some Related terms and their meaning to be 
known before going to Internet in detail. 
 
INTERNET SERVICE PROVIDER(ISP) 
ISP is a company that provides and sells physical 
Internet access to users. ISP is a company that provides 
access to the Internet.  
Examples:-   BSNL, tata docomo, Reliance, Airtel, Vodaphone, 
Aircel, etc. 

 
MODEM 
Modem stands for Modulator/De-modulator. Modem is a 
hardware device that allows a computer to transmit and 
receive information over telephone lines. A modem converts 
digital data from computers into analog data that can be transmitted 
over the telephone lines. Traditional modems can carry data at speeds 
of up to 56Kbps. Kbps stands for Kilobits per second. Kbps is a 
measure of data transmission speed 
 

PROTOCOL 
Protocol is a standardized means of communication among machines 
across a network. Protocols allow data to be taken apart for faster 
transmission, transmitted, and then reassembled at the destination in the correct order. The protocol 
used determines the way errors are checked, the type of compression, the way the sender indicates 
the end of the transmission, and the way the receiver indicates that the message has been received. 
Protocols can describe low-level details of machine-to-machine interfaces (e.g., the order in which 
bits and bytes are sent across a wire) or high-level exchanges between allocation programs (e.g., the 
way in which two programs transfer a file across the Internet). 
 

INTERNET PROTOCOL  (IP) 
Internet Protocol is the most basic protocol to communicate on the Internet. An IP number is a 
numerical address consisting of four numbers seperated by periods. Each IP address uniquely 
identifies a certain computer on the Internet. The domain name is used to make using them easier. 
Examples:- 62.109.133.133 (This is IP number for fcbayern.de) 
                  62.97.112.167 (This is IP number for fcbarcelona.com) 
                 193.111.180.25 (This is IP number for arsenal.com)            

 
DOMAIN NAME/ WEB SERVERS 
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This is the unique name that identifies an Internet site. Domain Names always have at least two 
parts, which are separated by dots. The part on the left is specific whereas the part on the right is 
more general such as com refers to Commercial Site, in refers to India, org refers to Organisation 
etc. Examples:- yahoo.com, google.com, rediff.com,  amazon.in, 
olx.in etc.  

 
BROWSER (WEB BROWSER) 
Web Browser or Browser is a program that allows a user to find, 
view, hear, and interact with material on the World Wide Web.  Web 
Browser or Browser is a software program that lets you find, see, 
and hear material on the World Wide Web, including text, graphics, 
sound, and video. Popular browsers areNetscape Navigator, Mosaic, 
Opera, Internet Explorer. 

 
 
WWW 
The World Wide Web (www) is an information space where documents and other web resources are 
identified by URLs, interlinked by hypertext links, and can be accessed via the Internet. It has 
become known simply as the Web. 
The World Wide Web (www) is an information space where documents and other web resources are 
identified by URLs, interlinked by hypertext links, and can be 
accessed via the Internet. It has become known simply as the Web. 
The World Wide Web was central to the development of the 
Information Age and is the primary tool billions of people use to 
interact on the Internet.  
 
The World Wide Web was invented by English scientist Tim 
Berners-Lee in 1989. He wrote the first web browser in 1990 while 
employed at CERN in Switzerland.  
Web pages are primarily text documents formatted and annotated 
with Hypertext Markup Language (HTML). In addition to formatted 
text, web pages may contain images, video, and software components that are rendered in the user's 
web browser as coherent pages of multimedia content. Embedded hyperlinks permit users to 
navigate between web pages. Multiple web pages with a common theme, a common domain name, 
or both, may be called a website. Website content can largely be provided by the publisher, or 
interactive where users contribute content or the content depends upon the user or their actions. 
Websites may be mostly informative, primarily for entertainment, or largely for commercial purposes. 

HOW WWW OR WEB WORKS? 
On the simplest level, the Web physically consists of the following components  

 Your personal computer − This is the PC at which you sit to see the web. 

 A Web browser − A software installed on your PC which helps you to browse the Web. 

 An internet connection − This is provided by an ISP and connects you to the internet 
to reach to any Website. 

 A Web server − This is the computer on which a website is hosted. 
Routers & Switches − They are the combination of software and hardware who take your 
request and pass to appropriate Web server. 
 

APPLICATIONS OF INTERNET 
Internet is today one of the most important part of our daily life. There are large numbers of things 
that can be done using the internet and so it is very important. You can say that with the progress in 
the internet we are progressing in every sphere of life as it not only makes our tasks easier but also 
saves a lot of time. Today internet is used for different purposes depending upon the requirement. 
Here in this very article we have mentioned then ten best uses of the internet. Here goes the list. 
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Communication 
At the moment the easiest thing 
that can be done using the internet 
is that we can communicate with 
the people living far away from us 
with extreme ease. Earlier the 
communication used to be a 
daunting task but all that chanced 
once internet came into the life of 
the common people. Now people 
can not only chat but can also do 
the video conferencing. It has 
become extremely easy to contact 
the loved ones who are in some 
other part of the world. 
Communication is the most 
important gift that the internet has given to the common man. Email, social networking sites are some 
of the prime example of it. This is one such gift of the internet which is cherished by everyone and 
has made our life easier to much extent. 

Research 
Now the point that has been placed next is research. In order 
to do research you need to go through hundreds of books as 
well as the references and that was one of the most difficult 
jobs to do earlier. Since the internet came into life, everything is 
available just a click away. You just have to search for the 
concerned topic and you will get hundreds of references that 
may be beneficial for your research. And since internet is here 
to make your research public, you can then benefit a large 
amount of people from the research work that you have done. 
Research is one such thing which has got lots of benefit from 
this evolution of internet. Research process has now got wings and has gained the most due to the 
internet.  

Education 
The next point that we have in this list is 
education. Yes you read it right. Education is one 
of the best things that the internet can provide. 
There are a number of books, reference books, 
online help centers, expert’s views and other 
study oriented material on the internet that can 
make the learning process very easier as well as 
a fun learning experience. There are lots and lots 
of websites which are related to different topic. 
You can visit them and can gain endless amount 
of knowledge that you wish to have. With the use 
of internet for education, you are non-longer 
dependent on some other person to come and 
teach you. There are various number of tutorials 
available over the internet using which you can learn so many thing very easily. There can’t be any 
excellent use of the internet other than education as it is the key to achieve everything in life.  

Financial Transaction 
The next use mentioned here is financial transaction. Financial transaction is the term which is used 
when there is exchange of money. With the use of 
internet in the financial transaction, your work has 
become a lot easier. Now you don’t need to stand in 
the queue at the branch of your particular bank rather 
you can just log in on to the bank website with the 
credential that has been provided to you by the bank 
and then can do any transaction related to finance at 
your will. With the ability to do the financial transaction 
easily over the internet you can purchase or sell items 
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so easily. Financial transaction can be considered as one of the best uses of resource in the right 
direction.  

Real Time Updates 
Real time updates have been placed at the number fifth position here. This has been mentioned here 
in regards to the news and other happenings that may be on-going in different parts of the world but 
with the use of internet we come to know about it 
very easily and without any difficulty. There are 
various websites on the internet which provides 
you with the real time updates in every field be it in 
business, sports, finance, politics, entertainment 
and others. Many a time the decisions are taken on 
the real time updates that are happening in various 
parts of the world and this is where internet is very 
essential and helpful.  
 

Leisure 
Leisure is the option that we have next in the list. 
Yes you heard it right. Right from watching your 
favorite videos to listening songs, watching movies, 
playing games, chatting with the loved ones has 
been possible due to internet. Internet has 
progressed with so much pace that today whenever 
you get time, you just move on to the internet and so 
such activities which helps you to relax. Leisure is 
one of the most important uses of internet and that 
has surely one thing that attracts people towards it. 
Internet is home of some of the excellent resources 
using which you can freshen up your mood in 
minutes.  
 

Online Booking 
Do you remember the time when the only way to book the railway 
tickets or bus tickets or plane tickets was to visit their centres at 
the designated location? That time has completely changed and 
today everything is available at the mouse click. This has been 
possible only because of the internet. Not only the online booking 
process is easier as well as less tedious but is also reliable. There 
is no need to visit the booking counters to book tickets or to 
contact the agents that might ask for more money in order to 
process your request. You can do all these things sitting at home, 
using internet. This is the reason it has been placed at the number 
seventh place in this list. The booking process has simplified 
because of the internet and this is the best use of the resources 
that you have.  
 

Job Search 
Job search is one such thing which required 
updates from every corner as well the patience 
from the person searching for it. Using internet, 
this has become an easier task. Job search has 
been placed at the number eighth place. There are 
endless amount of websites on the internet that 
provided with the news about the vacancy in 
various companies. You just need to get yourself 
registered at these website and they will do the 
rest. They will not only send you the email 
mentioning job vacancy according to your choice 
but will also help you to select the best out of 
them. Job search is easier now, all thanks to internet else it was a nightmare earlier. 
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 Blogging 
There are many people who are very much interested in 
writing blogs and for them internet is the best place. They 
can not only write blogs as per their wish but can also 
publicize their work so that their work reaches to most of 
the people and they get appreciated. There is huge number 
of websites over the internet which allows you to write 
blogs. You just need to get yourself registered as per their 
procedure and then start writing. And if your blogs are really good and so many people visit your blog 
then there is chance that you might get elected to write blogs for big organizations. Blogging has 
reached to all new level with the help of internet and is one such use which is beneficial to everyone.  

Shopping 
Yes you read it correctly. This very list starts with the point 
mentioned as shopping at the tenth place. Shopping has now 
become one of the most pleasing things to do using the internet. 
Whenever you find time, just visit the concerned websites and 
order the items that you need from there. Those items will be 
delivered to you in best possible time. There is huge number of 
options available for a common people to buy or to sell any 
particular item using the internet. Using internet now it is 
possible to buy products from all over the world. 

 
 

SEARCH ENGINE 
Search Engine is a program that searches documents for specified keywords and returns a list of the 
documents or Web pages where the keywords were found. Search Engine is an Internet site that 
allows users to search for specific information or Web sites. Popular Search Engines are:-  
www.altavista.com/ 
www.webcrawler.com/ 
www.msn.com/ 
www.google.com 
www.hotbot.com/ 
www.lycos.com/ 
www.yahoo.com/ 
www.searchengine.com 
www.excite.com/ 
www.cnn.com/ 
www.netscape.net/ 
www.start.co.tz/ 
www.infoseek.com/ 
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EMAIL 
10.1 E-mail (Electronic Mail) is the mail system that is used on the Internet to pass 
messages from one person or group of people to another. The 
systems also permits the transmission of pictures and sounds.E-mail 
means Messages, usually text, sent from one person to another via 
computer. E-mail can also be sent automatically to a large number of 
addresses (Mailing List). Electronic mail or email is a quick way of 
sending messages to people using the internet. You send an email to 
a person’s email address.  
 
10.2 E-MAIL ADDRESS 
E-mail Address is the unique Internet address to which your e-mail is 
delivered. A complete E-mail address is composed of the username, "@" and the name of the server 
where the user's mailbox resides. For instance username@domain name. 
Suppose your E-mail address is 
Rajesh@yahoo.com. Your username is Rajesh. 
Your mail is on theYahoo.com server. Generally, E-
mail addresses are case insensitive. If mail is 
undeliverable because of a bad address, you 
receive a message. If the message indicates "user 
not found," you probably made a spelling error to 
the left of the "@." However, if the error message 
indicates "server not found," the problem is to the 
right of the "@." 
 Some Examples of E-mail Addresses are:- 
pramod@hotmail.com 
smaran@yahoo.com 
suvali@sify.com 
ganesh@gmail.com 
nirmal@rediffmail.com 

10.2.1 USERNAME 
Username is the name that identifies a user to a computer network; generally used in conjunction 
with a password to establish the user's right to access a host (server). Username can also be known 
as ID or Screen Name or Login Name or Sign In Name 
Examples:- rajesh, pramod, smaran etc 

10.2.2 PASSWORD  
Password is a secret combination of characters used 
to access a secured resource such as a computer, a 
program, a directory, or a file; often used in 
conjunction with a username. 

10.3 ATTACHMENT 
AN Attachment is a file that is sent along with an e-
mail message. Examples Picture File, Microsoft Excel 
file, Microsoft Word file, Microsoft Access file etc. 

 
10.4 CLIENT/Web Browser 
Client is a computer system or process that requests 
service from another computer system or process (server). Client is 
a software program that is used to contact and obtain data from a 
Server software program on another computer, often across a great 
distance. Each Client program is designed to work with one or 
more specific kinds of Server programs, and each Server requires a specific kind of Client. A Web 
Browser is a specific kind of Client. 

10.5 Sending messages 
 If you are new to Gmail, the following lines help you. Here's a step-by-step guide on 

composing and sending messages: 
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 Click the Compose button on the left side of 
your Gmail page. 

 Type your recipient's email address in the 
“To” field. 

 As you type a recipient’s address, Gmail will 
suggest addresses from your Contacts list 
using auto-complete. 

 Once you've entered a contact in the "To" 
field, hover over the contact’s name to see 
the email address and other information 
associated with it. Double-click a contact’s 
name to edit the email address or name. 

 We suggest using the carbon copy feature 
when you'd like to include additional 
recipients whose responses are welcome 
but not required. Display this field by 
clicking Cc. The blind carbon copy field (click Bcc to display) lets youhide recipients' 
addresses and names from one another. 

 Enter a subject for your message in the “Subject” field. 
 Write your message! Just click in the large field below the subject line and type away. 

 When you're done composing, click the Send button at the bottom of your compose window. 

 These are just the basics of composing mail, but there’s a lot more you can do, like change 
the color of your text, or add a signature.  

10.6 What's a signature? 

A signature is a way to include the same details on all your sent messages. 

Things you can include in a signature: 

 Your name, phone number, and other contact information. 

 A link to your website. 

 A personalized note to your recipients. 

 Your latest Tweet from Twitter. 

10.6.1 Add a signature 

 Good to know - Is your signature not the right fit for an email you're sending? Just delete part or all 

of it before you click Send. 

1. Mouse over the Settings menu icon  | select Settings. 

2. Click Accounts. 

3. Click Primary Yahoo. 

4. Select "Append a signature to the emails you send." 

- You can also select "Include your latest Tweet from Twitter." The tweet can be deleted 

before you send a message if you don't want it included for that email. 

5. Enter your signature text in the Signature field. 

6. Click Save. 

10.6.2 Edit a signature 

1. Mouse over the Settings menu icon  | select Settings. 

2. Click Accounts. 

3. Click Primary Yahoo. 

4. Make your edits in the Signature field. 

5. Click Save.  

10.6.3 Disable a signature 

1. Mouse over the Settings menu icon  | select Settings. 

2. Click Accounts. 

3. Click Primary Yahoo. 

4. Uncheck "Append a signature to the emails you send." 

5. Click Save. 
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10.7 Creating a vacation response 

1. Mouse over the Settings Menu icon | select Settings. 

2. Click Vacation Response. 

3. Select Enable during these dates (inclusive). 

4. Select a start and end date for your vacation response. 

5. Enter the response you want senders to see in the "Message" field. 

- Each sender receives only one vacation response, no matter how many times they email 

you. 

6. Click Save. 

10.7.1 Send different responses to senders from specific domains 

1. Select Different response to emails from a specific domain. 

2. Enter up to two domain names. 

3. Enter a different response in the "Message" text box. 

4. Click Save. 

10.7.2 Turn off the vacation response early 

1. Mouse over the Settings Menu icon | select Settings. 

2. Click Vacation Response. 

3. Deselect Enable auto-response during these dates (inclusive). 

7. Click Save. 

10.8 Downloading and Uploading 

10.8.1  What is Downloading? 

Downloading generally transfers the whole data object for local storage and later use, 

as contrasted with streaming, where the data is used nearly immediately, while the 

transmission is still in progress, and which may not be stored long-term. 

Increasingly, websites that offer streaming media or media displayed in-browser, 

such as YouTube, and which place restrictions on the ability of users to save these 

materials to their computers after they have been received, forbid downloading in the sense of 

"receive and save" rather than simply "receive". Downloading is not the same as "transferring"  (i.e., 

sending/receiving data between two storage devices would be a transferal of data, but receiving data 

from the Internet would be considered a download). 

10.8.2 What is uploading? 

Uploading is the process of moving digital files such as photographs or documents 

from your computer and placing them on to a central server so that someone else 

can retrieve them or to a website so others can see them. For example, you might 

save photographs from your digital camera on to your computer and upload them 

on to a social network such as Facebook, where you can allow friends and family 

to see them. 

10.9 What is online bill payment? 

Online bill pay is an electronic payment service that allows you to 

set up a secure online account to make one time or recurring bill 

payments. The source of funds for the payments is usually a 

checking account, but some bill pay services also work with credit 

cards. All bills and transactions are accessed on the bill pay 

website. 

Tips for Choosing Online Bill Pay Services: 

https://en.wikipedia.org/wiki/Streaming_media
https://en.wikipedia.org/wiki/YouTube
http://financialsoft.about.com/od/glossaryindexe/f/Electronic_Pay.htm
http://financialsoft.about.com/od/onlinesoftware/ig/Online-Bill-Pay-Services/
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Electronic Funds Transfer vs. Check 
It's best to set up payments with companies that will accept the payments electronically, but online 

bill pay services can cut and mail a check when electronic payments are not accepted. Be sure to all 

extra time and plan ahead - usually five business days - for the check to be cut and mailed. 

Cost 
There are some very good free online bill payment services. If you want more features, like the ability 

to view months worth of bills online, you will probably have to use an online bill pay provider that 

charges a monthly fee. This cost is worth it for most people, considering the elimination of the cost of 

postage and checks otherwise used to pay bills. Alternatively, you may have access to free online bill 

pay features through online banking offered at a financial institution you already hold an account at. 

 

 

 

 
 

 
 

 

http://financialsoft.about.com/od/Online-Banking/qt/Online-Banking-Definition.htm
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GOOGLE DRIVE 

11.1 Google Drive 

Google Drive is a potential go-to note-taker even though it’s generally designed as a word 
processor. The productivity suite has some key advantages that the note-taking not-quite-

competition fail to offer, at least as a singular package. 

 

 

 

First of all, all of your docs (or notes in this case) are saved in Google Drive, which has the 

best search capabilities around, hands-down. That makes it easy to find the note your 

looking for in a flash. Evernote's search is good, but not as good as Google's. 

http://www.ebay.in/sch/i.html?_nkw=case
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You also can use Drive’s excellent collaboration feature to write and share notes with 

others in real-time—an especially useful scenario if you're doing a group project with 

colleagues or classmates.  

11.2 Set up an organizational structure 

The first step is to create a folder for all your notes—

even though Drive’s search capabilities are 

excellent, it still helps to have some kind of 

organizational plan for your notes and other files. 

You could just set up one blanket folder called Notes 

that you stuff all of these into, or you could get more 

specific with folders for meeting notes, agendas, 

recipes, or perhaps even individual classes if you’re 
a student. Drive also lets you nest folders if you want 

to further subdivide your organizational system.  

 

11.3 Collaborative note-taking 

If you’re working on a project with others, you 

still can’t find a better real-time collaboration 

app than Google Docs.  
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Google Drive makes it exceptionally easy to share a page of notes with a colleague—just 

use big blue Share button in the corner and fire away. Even better, the Docs commenting 

system allows you to ask questions or discuss any of the material back and forth right 

inside the file. 

11.4 Search smarter in Google Drive 

Google’s search is usually best in class, but sometimes you'll need some additional tools to 

hone in on what you're trying to find. Drive has several parameters that can refine your 

search, which is especially useful if the only thing coming to mind is a common term that 

could be in a large number of files you have saved. 

You can specify what type of file you're trying to find—perhaps you want an image you 

scanned or a doc. If someone else started the file, you can look for one where they're the 

owner, saving you from too many search results that point you in the wrong direction. 

Drive also supports powerful search modifiers similar to the ones you can use in the 

Google Search, which can help you narrow your queries down to incredibly granular levels. 

Check out the "Advanced Search Options" section of Google Drive's search help page for a 

full list.  

 

https://support.google.com/drive/answer/2375114?hl=en
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GLOSSARY ON INTERNET TERMS 
As an important supplement of this chapter, we have included in the following lines the meaning of 
some of the most used terms used in the world network of networks 

 
ADSL (Asymmetric Digital Subscriber Line): 
Asymmetric system of data transmission over conventional telephone lines. There are working 
systems that reach speeds up to 1,5 and 6 Megabit per second in one way and between 16 and 576 
Kilobytes in the other.  

ANSI (American National Standard Institute): 
API (Application Program Interface): 

APPLET: 
Written and compiled JAVA application. 

ARPANET (Advanced Research Projects Agency Network): 
Military network of the United States of America through telephone lines from which Internet 
derivative. 

ASAP (As Soon As Possible): 
Command or option in a network or program which determines the priority of a task. 

ASCII (American Standard Code for Information Interchange): 
The ASCII character table is composed of 128 characters including symbols and control characters. 
An extended version of 256 exists. 

ASN (Autonomous System Number): 
Set of routers and networks controlled by the same management authority. 

ATM (Asynchronous Transmission Mode): 
System of data transmission used in wide band in order to take the maximum advantage of a line. It 
is a packet switching system supporting transmission speeds of up to 1,2 Gbps. 

Avatar: 
An graphic identity which a user’s adopts when connected to a CHAT with graphical capacities. 

BBS (Bulletin Board System): 
Communications server that furnishes various services to the users, such as e-mail or file transfer. 
Originally worked through normal telephone lines and which can be currently found in Internet. 

Bandwidth: 
Capacity of a transmission media.  

Bounce: 
Return of an e-mail message due to problems in delivering it.  

Browser: 
Term normally applied to the programs which provide access to the WWW service. 

Bookmark: 
Mark, usually of a WWW address, that remains filed for further use. 

COOKIE: 
Small portion of data that the server of HTTP furnishes WWW to keep. Normally is Information about 
the connection or the data required? By this it can know what did  

DNS (Domain Name System): 
Distributed database which manages the conversion of Internet addresses which are expressed in 
natural language into an IP numerical address. For example 121.120.10.1. 
Dialup: 
Process by which a data connection through a telephone line is established. 

Domain: 
Host domain system in Internet. The domains go separated by a dot and are hierarchically organized 
from left to right. 

Download: 
It refers to the act of transferring a file or files from a server to our computer.  

E-mail (Electronic Mail): 
Message data system similar in many ways to ordinary mail but much faster. 

FAQ (Frequent Asked Question): 
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File system containing the most frequently asked questions and answers of a particular topic. 

FTP (File Transfer Protocol): 
One of the most used file transfer protocols.  
Firewall: 
Any program which protects a network from another network. Firewall gives access to a local network 
machine in Internet but Internet does not see further than firewall. 

Homepage: 
Main or initial page in a website. 

HTML (HyperText Markup Language): 
Language to elaborate web pages, currently in version 3.0. Developed in the CERN. 

Hacker: 

Computer expert capable of entering in restricted access systems. Does not have necessarily 
harmful intentions. 
IP (Internet Protocol): 
This denomination includes all the Internet protocols. It also refers to the addresses of the Internet 
network. 

ISDN (Integrated Services Digital Network): 
Telephone network with bandwidths starting from 64Kbps. Similar to the voice telephone network 
regarding the needs of installation interface to the user, but digital. In Spanish: "RDSI". 

JAVA: 
Object oriented programming language similar to C++. Used in WWW for tele-load and tele-

execution of programs in the customer computer. Developed by Sun Microsystems. 
JPEG (Join Photograph Expert Group): 
Graphic format with losses which reaches high ratios of compression. 

LAN (Local Area Network): 
Network of computers of small dimension. For example, a network distributed in one story of a 
building. 

Link: 
This is used to call the parts of a web page which take us to another part of it or connects us to 
another server. 

MODEM (Modulator/Demodulator): 
Device that adapts digital signals for their transmission through an analog line, normally telephone. 

MPEG (Motion Pictures Expert Group): 
Graphic format of video storage. Uses like JPEG compression with losses, reaching high rates. 

NC (Network Computer): 
Computer conceived to operate connected to Internet. According to many, it is the future. These are 
very reduced hardware machines (some don't even have a hard disk). 

NEWS: 
Internet service with a billeting board structure divided in topics and countries, in which the users of 
certain interest groups leave or respond to messages related  

Node: 
By definition a point where two or more lines converge. Sometimes it refers to a single machine in 
Internet. Normally it refers to a confluence point in a network. 

OEM (Original Equipment Manufactured): 
Company that buys a product from a manufacturer and integrates it with one or more of its own 
manufacture. All manufacturers, for example, which include a Pentium in their systems act as an 
OEM. 

PAN (Personal Area Network): 
Network system directly connected to the skin. The data transmission is carried out by physical 
contact.  

PING (Packet INternet Groper): 
Program used to check if a host is ready. Sends control packets to check if the host is active and 
thus returns them. 

PPP (Point to Point Protocol): 
Internet Protocol to establish a connection between to points. 

PROXY: 
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Proxy is a server normally connected to the access server to the WWW of an access provider that 
saves all the information that the users receive of the Web, therefore, if another user accesses 
through Proxy to a previously visited site, he will receive the information from the Proxy server 
instead of from the real server. 

Packet: 
Minimal amount of data transmitted in a network or between devices. Has a different structure and 
length according to the protocol to which belongs. Is also called TRAMA. 

Router: 

Device connected to two or more network in charge only of the communication tasks. 
SMS (Short Message Service): 
Electronic text message service between telephones GSM. With this you can also send e-mail from a 
GSM telephone and receive messages from Internet, though this possibility seems not to work in 
Spain. 

Spam / Spammer: 
This is how the e-mail "bombing" is called, this means to send mail or very long messages.  

SIM (Single Identification Module): 
Normally referred to a card: SIM card. Which identifies and through it gives service to a user. Its most 
common application is through GSM telephones. 

URL (Unique Resource Locator): 

Denomination that not only represents an Internet address but also points to a specific resource 
within such address. 

Webcam: 
Camera connected to a web page through which the visitors can normally see images directly. 
 

Project Work: 

 Prepare a presentation on “Odisha Tourism” 

 Prepare a Presentation using the details of “Internet and Its Application”  
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